
About this Manual…
Copyright Notice

This manual was written for use with Cookie Crusher v2.6 software.    This user manual and the Cookie 
Crusher software described herein are protected under U.S. copyright law and international treaty 
provisions.    The user manual and Cookie Crusher software may not be copied, except as otherwise 
provided in your software license agreement, or as expressly permitted in writing by The Limit Software, 
Inc.

Copyright © 1997-2000 The Limit Software, Inc. All rights reserved.    The Limit Software and Cookie 
Crusher are trademarks of The Limit Software, Inc.

How to Report Violations

The Limit Software supports the industry's effort to fight the illegal usage of computer software.    Report 
copyright violations to The Limit Software (piracy@thelimitsoft.com) or to: 
                                                                                                
Software & Information Industry Association
1730 M Street NW, Suite 700
Washington, DC 20036
piracy@siia.net

Additional Copyright and Trademark Notices

Windows is a registered trademark, and Internet Explorer is a trademark of Microsoft Corporation.

Netscape and Netscape Navigator are registered trademarks, and Netscape Communicator is a 
trademark of Netscape Communications Corporation.

All other trademarks and service marks are the property of their respective owners.



Installation and System Requirements
System Requirements

To use Cookie Crusher, you must have the following:

· Windows 95, Windows 98, Windows NT 4.0 or Windows 2000
· 32-bit version of Netscape Navigator/Communicator v3.x or 4.x and/or Microsoft Internet Explorer 

v4.x or higher and/or Opera* v3.x or higher

* Cookie Crusher cannot control Opera cookies in real-time, but can display and delete stored Opera cookies.

Uninstalling Cookie Crusher

· Click on the Start menu and go to Settings -> Control Panel -> Add/Remove Programs.    Finally, 
double-click on the “Cookie Crusher” item in the listbox.



Product Description
Cookie Crusher, an award-winning Internet cookie manager, works with your web browser to give you 
complete control over the cookies which are accepted by and stored on your system.

Cookie Crusher controls cookies in real-time before they are placed on your hard drive.    Real-time cookie
controlling technology has many distinct advantages over other methods.    Benefits include the following:

· All cookies are handled.    With static technology (e.g. programs that delete or alter the actual cookie 
files), only cookies that are “stored” on your hard drive after the browser is closed are edited.    
Cookies that are accepted by the browser in temporary memory, but not stored in the cookie text 
file(s), are not controlled since they never appear in the cookie text file(s).      

· There is no need to run any program after you are done browsing.    All cookies are handled while you
utilize the World Wide Web.

· Cookies are never placed on your hard drive unless you specifically allow them to be there.    There is 
no need to edit cookies that are on your hard drive after browsing.

· You can filter out cookies based on specific servers.    Programs that alter the registry only allow you 
to accept all or reject all cookies.

Program Features

Cookie Crusher includes the following features:

· Automatically and transparently accepts or rejects all or specific cookies from particular servers 
without user interaction.    

· Cookies received from unspecified servers can be automatically accepted or rejected without user 
interaction, or the user can be asked for confirmation.

· Quick adding of servers to the “accept from” and “reject from” lists.    This allows you to manually 
accept or reject a cookie once and subsequently accept or reject it each and every time it is received. 

· Aids you in determining a cookie’s classification and function.    The program will inform you whether 
the cookie is used for ad tracking, e-commerce, or site tracking.    

· Keeps a detailed list of the cookies accepted and rejected from all servers for the current session, 
with an added option to save the list to a file for later perusal.

· Allows all cookies already on the system to be viewed and deleted.
· Detects when your web browser is opened and can optionally load your browser when its not opened.

In addition, it can open and close itself in conjunction with a web browser or any other program of 
your choice.

· Full 32-bit application, designed exclusively for use on Windows 95, Windows 98, Windows NT 4.0 
and Windows 2000 platforms.



Cookies:    A Brief Tutorial
cookie 1) noun – a small, sweet cake 2) textual information stored on your hard drive by a web site for 
later retrieval

A cookie is data that a web site sends to your browser to store on your computer's hard drive for later 
retrieval.    The stored data is then sent back to the web site every time you visit that site. The data can 
contain information such as a user name and password for that site, items you are purchasing on a 
shopping site, or any other information the web site has been set up to ask you for.    Some cookies are 
not stored on your hard drive.    These cookies are known as “non-persistent” cookies and will expire once
the web browser is closed.

Cookies can NOT…

· Place a virus or other data threatening item onto a computer system
· Read files off a user’s hard drive (e.g. they cannot obtain a list of hard drive directories)

Cookies CAN…

· Take up marginal amounts of disk space (often no more then a few kilobytes)
· Enhance web site tracking abilities 
· Allow advertisers and other marketers to accumulate user profiles and build market data 

The latter two reasons often cause concern among privacy advocates. 

Site Tracking
Web site maintainers can use cookies to aid their web server logs.    Web server logs usually record the 
time and date of a person’s visit as well as their Internet protocol (IP) address, the previous web page 
they were visiting (often called the “referrer”), and the browser they were using to access the site.    Often 
the IP address is not enough to target an exact user’s path through a site, since proxy servers and other 
reasons can allow more then one person to use the same IP address.    Thus, webmasters turn to 
cookies.    If the user accepts the “site tracking” cookie, the web site maintainer will be able to more 
accurately “track” each individual visitor.

Advertisements
Large advertisers that span several web sites use cookies to build user profiles.    These profiles allow 
them to more accurately target a user’s preferences, so the user would be more inclined to click on one of
their ads.      This technique is similar to what retail stores do with their “preferred” customer cards.    These
cards give the buyer a small discount in order to entice them to use it, and, in return, the retailer has a list 
of everything the buyer purchases and can use that information to more accurately plan marketing 
campaigns.

Shopping Cart
Web site shopping cart CGI scripts sometimes require cookies in order to accurately track a customer’s 
purchase (the shopping basket).    Though there are other ways to do this without using cookie 
technology, many e-commerce stores use cookies since the tracking capabilities make it slightly harder to
conduct fraudulent transactions.



Browser Setup
If you installed Cookie Crusher using its installation program, these options should be adjusted for you 
automatically.    These manual instructions are provided in case of unusual circumstances.

Both Netscape Navigator and Microsoft Internet Explorer can display warning messages before a cookie 
is accepted.    This option must be enabled in order for Cookie Crusher to work. 

Microsoft Internet Explorer 5.x

· While in Internet Explorer, navigate to the “Tool” menu and select the “Internet Options” command.
· Click on the “Security” tab from the dialog box that appears.
· Select the first zone, “Internet.”    Click on the “Custom Level” button.
· Scroll down the list to the “Cookies” options.    
· Change all cookie options to “prompt.”
· Click “OK.”    Repeat this step for the next three zones.

Microsoft Internet Explorer 4.x

· While in Internet Explorer, navigate to the “View” menu and select the “Options” or “Internet Options” 
command.

· Click on the “Advanced” tab from the dialog box that appears.
· Scroll down the list until you locate the option “Prompt before accepting cookies” which is under the 

“Cookies” heading.
· Make sure the above option is enabled.
· Click “OK” to close the dialog box and save the adjusted settings.

Netscape Navigator 3.x

· While in Netscape, navigate to the “Options” menu and select the “Network Preferences” command.
· Select the “Protocols” tab from the dialog box that appears.
· Make sure the “Accepting cookies” option is checked.
· Click “OK” to close the dialog box and save the adjusted settings.

Netscape Navigator 4.x

· While in Netscape, navigate to the “Edit” menu and select “Preferences.”
· Click on the word “Advanced” in the category list displayed on the left.
· Make sure the “Accept all cookies” option is checked.
· Click on the “Warn me before accepting a cookie” option.
· Click “OK” to close the dialog box and save the adjusted settings.



Using Cookie Crusher – The Tray Icon
When you run Cookie Crusher, an icon is added to the taskbar tray (the area in the bottom right corner of 
the screen where the system clock usually resides).    This icon can be used to interact with Cookie 
Crusher. 

The main Cookie Crusher window is not initially displayed when you start the program. To display the 
main window, you can either double click on the tray icon, or you can right click on the tray icon and select
the “Show” command from the pop-up menu.    If the main window is currently displayed, you can click on 
the “OK” or “Cancel” buttons to hide it. 

Tray Icon Mini Menu
Clicking on the tray icon with the right mouse button will display a pop-up menu. This menu has the 
following commands on it:

· Show
This option will display the main Cookie Crusher window.

· Disable/Enable
This option will either disable or enable Cookie Crusher. This allows a user to disable Cookie 
Crusher’s functionality without shutting it down. Cookie Crusher will no longer intercept cookies. 
The user will see a warning message whenever a cookie is received. Click on this option again to 
enable cookie checking.

· Help Topics
This option will bring up Cookie Crusher’s manual.

· Update Check
Cookie Crusher will launch your default Web browser and inform you of any program updates.

· Web Site
This option launches your default Web browser and directs you to one of our corporate Web sites.

· About Cookie Crusher
Brings up the program’s “About” box which outlines version, copyright, and license information.

· Exit
This option will close Cookie Crusher.

Tray Icon Graphics
Cookie Crusher’s tray starts off in the “on” position signified by an “on” light bulb.    When you disable 
Cookie Crusher, the icon changes to an “off” light bulb.    When Cookie Crusher accepts a cookie, the icon
changes to a checkmark.    When Cookie Crusher rejects a cookie, the icon changes to a bullseye.    



Getting Started – A Quick Tutorial
The online version of this tour, which has pictures in addition to the text below, is available via the Web.

This section is designed to have you up and running with Cookie Crusher in just a few minutes.    To learn 
specifics about anything mentioned in this section, feel free to peruse the other topics available in this 
online manual. 

· Open up your web browser and visit a few web sites that you know send cookies.    If you are not 
seeing cookie alert window messages pop-up in your browser, see the Browser Setup section of this 
manual.

· Close your web browser.
· Start Cookie Crusher.    The default placement for the program is Start --> Programs --> The Limit 

Software --> Cookie Crusher.
· Double-click on the Cookie Crusher tray icon (the light bulb).
· You should see the Filters tab.    The top lists which sites you want Cookie Crusher to always accept 

or reject cookies from.    The bottom radio buttons determine what Cookie Crusher does with cookies 
that are not in either list.    For example, “accept all” accepts all cookies except for those listed in 
the “Reject from” list.    The “prompt for confirmation” option alerts you when Cookie Crusher receives
a cookie that is not found in either list.    The “reject only those that expire” option rejects only those 
cookies that would be stored on your hard drive after you surf.    

· Click on the Session tab.    Every time Cookie Crusher deals with a cookie, the appropriate 
information will be documented under this page.

· Click on the Cookies tab.    This page shows all the cookies stored on your system.    If the paths 
listed at the bottom are incorrect, you can enter in a correct path yourself.

· Click on the Configure tab.    The top of the page determines whether Cookie Crusher will load up 
with a program of your choice, with Windows, or only when you execute it.    You can also have 
Cookie Crusher launch another program when it starts by clicking on the “Load the following 
program…” option and specifying a program path.    The “Disable Question Sound” option determines
whether you want Cookie Crusher to disable the question window sound (associated with cookie 
warnings) temporarily while it’s running.    

· Click on the Settings tab.    The top part of this page determines what Cookie Crusher looks for in 
order to deal with cookie alert windows.    This section should only be altered if you know you have a 
customized browser (e.g. non-English or “co-branded” for an Internet Service Provider).    The bottom
half allows you to adjust various Cookie Crusher warning dialog boxes.

That should get you started.    Remember, if you want more detailed information about anything 
discussed, visit the related section in this manual.



Configure Tab
This page allows you to adjust Cookie Crusher’s general configuration options.

Program Start Options 

This frame details whether Cookie Crusher will load with other programs, with Windows, or only when 
you execute it.

· Start with the listed programs – If this option is enabled, Cookie Crusher will load with any program
that is shown in the listbox to the right of the option.    Thus, if you have “Netscape” listed in the box, 
any program that has “Netscape” within its title bar will cause Cookie Crusher to run.    When the 
programs listed in the box are no longer activate, Cookie Crusher will close automatically.

· Start with Windows – Cookie Crusher will start when Windows boots and you will see its icon in the 
tray immediately.

· Start manually – Cookie Crusher will not start until you execute it.    You will also have to close the 
program yourself.

Load the following program… -- When this option is enabled, Cookie Crusher will load the specified 
program when it loads. 

Cookie Crusher loads a small program called "CCWATCH.EXE" if you select the "Start with the listed 
programs" option.    This program uses minimal system resources and is required in order to open and 
close Cookie Crusher automatically.

Disable Alert Sound

On some systems, when Netscape Navigator displays a cookie alert window, a sound will occur as the 
window is displayed. When Cookie Crusher intercepts the message box it cannot prevent the sound from 
being played at that time. Selecting this option will cause Cookie Crusher to permanently disable the 
sound while Cookie Crusher is running. The downside to this is it will disable the sound for question 
boxes displayed by any other applications in your system. The sound is only disabled while Cookie 
Crusher is running, if this option is enabled. When you close Cookie Crusher, the sound setting will be 
restored in the registry.



Session Tab
This page documents each cookie that Cookie Crusher deals with during any Web session.

The log is spilt into the following columns:

· Server Name      
The first column displays the server that sent you a cookie.

· Action                 
The second column tells you whether the cookie was rejected or accepted.

· Category
The third column lists the category that Cookie Crusher determined the cookie filled, either 
“Advertisement,” “Shopping Cart,” “Site Tracking,” or “Unknown” if it could not be estimated 
accurately.

· Name
The fourth column shows the cookie’s name.

· Value
The fifth column shows the cookie’s value.    If the cookie does not have a value, the listing will be 
blank.

· Expires
The sixth columns shows the cookie’s expiration date.

· Time
The last column lists the time when the cookie was accepted or rejected by Cookie Crusher.

Cookie Counters

The left set of counters list the total number of cookies received during the current session, as well as 
how many of those were accepted and rejected.    The right set of counters shows the classifications of all 
cookies shown under the “Session Statistics” tab.    

Session Buttons

· Reject  - This button moves any highlighted server or to the “Reject from” list under the “Site Filters” 
tab.    For example, if you see a server that you would like Cookie Crusher to reject cookies from for 
now on, you would highlight the server under the “Session Statistics” box.    Then, click on “Reject” to 
move the server to the “Reject from” list.    If you want to reject a particular cookie from that server, 
right-click on the “Reject” button and select the “Server and Cookie” option.    Then, click on “Reject” 
to move the server to the “Reject from” list. 

· Accept - This button moves any highlighted server to the “Accept from” list under the “Site Filters” 
tab.    For example, if you see a server that you would like Cookie Crusher to accept cookies from for 
now on, you would highlight the server under the “Session Statistics” box.    Then, click on “Accept” to 
move the server to the “Accept from” list.    If you want to accept a particular cookie from that server, 
right-click on the “Accept” button and select the “Server and Cookie” option.    Then, click on “Accept” 
to move the server to the “Accept from” list.

· Clear – This button will clear the “Session Statistics” tab as well as the category totals listed under the
box.    

· Save - Cookie Crusher can take the “Session” log and store it into a text file of your choice.    Simply 
click on the “Save Session” button below the list, and notify the dialog box where you want the file 
saved.    Once saved, you can retrieve the file by using any text editor.



Cookies Tab
This page displays a list of cookies currently stored on your computer. The server that the cookie was 
received from, the cookie name and the cookie value are shown. You can use the buttons to display 
cookies stored by Netscape Navigator or by Internet Explorer. You can also delete any cookies that you 
want to.

Netscape (Radio Button)

Selecting this button will display Netscape Navigator stored cookies in the list.

Internet Explorer (Radio Button)

Selecting this button will display Internet Explorer stored cookies in the list.

Opera (Radio Button)

Selecting this button will display Opera stored cookies in the list.

Delete

This button will delete the cookie currently selected in the list above. The cookie will be permanently 
destroyed.

Refresh

This button will read the cookies again from disk and display the newly read cookies in the list above. 
Internet Explorer stores cookies as they are received, so if cookies have been received since you first 
displayed this list you can press the “Refresh” button to read the new cookies. Netscape Navigator and 
Opera only store the cookies permanently when they shut down, thus you will only see any new cookies 
after either browser is closed.

Path Settings

The paths for the selected browser are shown below the three radio buttons.    If any of the directories 
shown are incorrect, you may click on the “erase” button and change it to the correct path or directory by 
clicking on the “Add” button next to the path.    Click on the “reset” button if you want Cookie Crusher to 
reset to the default, original directories.    



Settings Tab
This page deals with “expert” settings for the program.    

Language Settings

These settings might have to be adjusted if your browser is not the “standard” versions of Internet 
Explorer or Netscape Navigator.    This could happen if you’re not using the English versions of the 
browser or have a co-branded version of the browser.

Netscape Window’s Title Bar – This setting should match the title bar of the Netscape cookie window. 
Netscape Window “wishes” – This setting corresponds to the English version of “wishes.”    
Netscape Window’s “persists until” – This setting corresponds to the English version of “persists until.”
Internet Explorer’s Title Bar – This setting should match the title bar of the Internet Explorer cookie 
window.    For example, the title bar of the standard Internet Explorer window is “Security Alert.”
Internet Explorer’s “Cookie” – This setting corresponds to the English version of the word “Cookie” as 
found in the standard Internet Explorer v4.x and v5.x cookie window.      
Internet Explorer’s “Yes” – This setting needs to match the “Yes” button in the Internet Explorer window.
Make sure to add the ampersand (&) before the word.

Warn If Settings

Netscape cookie file does not exist – If Cookie Crusher cannot automatically detect a Netscape cookie 
path and no cookie path is listed under the “Cookies” tab, Cookie Crusher will alert you so long as this 
option is checked.
Opera cookie file does not exist – If Cookie Crusher cannot automatically detect an Opera cookie path 
and no cookie path is listed under the “Cookies” tab, Cookie Crusher will alert you so long as this option is
checked.
Closing main program window – If you click on the X button in the upper right-hand corner of the main 
program screen, Cookie Crusher will alert you to see if you want to close the program so long as this 
option is checked.



Purchasing Cookie Crusher
The registration fee for a single copy license of Cookie Crusher is $15 USD.    When you place an order, 
you will receive by return e-mail or postal mail information on how to unlock your trial version. 

· Check or Money Order

To order by check or money order, simply visit our Web order form.

Alternatively, you can print out and send this manual order form and a check or money order made 
payable to The Limit Software. Instructions for ordering by check or money order are included on the 
order form. Payment must be in U.S. dollars drawn on a U.S. bank. Your registration information will be 
sent to you via e-mail or postal mail.

· Ordering by Credit Card 

Visa, MasterCard, and American Express are accepted.

Online:    You can order via the Internet using our SSL encrypted order form by visiting our Web store.

Telephone:    We have outsourced our telephone sales to NorthStar Solutions.    To order Cookie Crusher,
please locate the correct product ID number from the following list:

· 3826 – Cookie Crusher Single User-License - $15.00
· 3829 – Cookie Crusher Single User-License & Floppy Disk - $20.00

Then, call NorthStar Solutions toll-free at 1-800-699-6395 Monday through Friday, 9 a.m. - 7 p.m. CST.    If
you reside outside the United States, please call +1 785-539-3731.

Note:    We CANNOT be reached at the above numbers.    Please contact The Limit Software for anything 
regarding the product, including but not limited to order status, technical support, and customer service 
related inquiries.

Fax:    You can fax our standard order form to us at 219-392-2466.    We recommend trying the Web form 
before resorting to the printable form.

Postal Mail:    You can send all postal mail credit cards orders to us at The Limit Software, PO Box 580, 
East Chicago, IN 46321-0580.    Please use either the Web order form or the manual form.

· Site Licenses

A site license for Cookie Crusher allows a business or organization to receive a signed license agreement
to register Cookie Crusher on a specified number of computers. Site license pricing is indicated below. All 
prices listed are in U.S. funds.

2 to 9 computers: $12 each
10 to 24 computers: $10 each
25 to 49 computers: $9 each
50 or more computers: $7 each



Technical Support
The Limit Software provides technical support via e-mail, regular postal mail, or fax. You should always 
check the web site (www.thelimitsoft.com) before requesting support to make sure you are using the 
latest version of Cookie Crusher, and to see if the problem you are having has already been resolved.

When requesting support please be sure to include the following information:

· Your name and contact information (either e-mail address (preferred), street address for regular mail, 
or fax number for fax).

· What operating system are you using? For example, Windows 95/98, Windows NT 4.0 etc.
· What version of Cookie Crusher are you using? You can select the “About” option from the main 

screen to find the version of Cookie Crusher you are using.
· Nature of the problem?
· Does the problem occur often?
· If an error message was displayed, please include the full text of the error message including the 

number (if applicable).

Internet Support (Fastest method, 24-hour turnaround time)

Please send an e-mail to our support department at support@thelimitsoft.com, or post your message to 
our online technical support message board. Please include the above information.

Fax

Please send your fax to 219-392-2466.    Be sure to include the above information and please print or type
neatly.

Postal Mail Support

Please send mail to the following address:

The Limit Software
Attn: Technical Support
PO Box 580
East Chicago, IN 46312-0580
USA

Be sure to include the above information.



License Agreement
This Software License Agreement (the "Agreement") is a legal Agreement between an individual or entity 
and The Limit Software, Inc. ("The Limit Software").    The Software application ("Cookie Crusher") which 
accompanies this license (the "Software") is protected by United States copyright laws and international 
treaty provisions.    By continuing the installation of the Software, by loading or running the Software, or by
placing or copying the Software onto your computer hard drive, you agree to be bound by the terms of 
this Agreement.

1.    Grant of License.    The Software is provided on a 30-day trial basis free of charge.    This is intended 
to allow you time to decide whether to purchase the software.    If you use this software after the 30 day 
evaluation period, a registration fee is required. Unregistered use of Cookie Crusher after the 30-day 
evaluation period is in direct violation of this Agreement.    

The Agreement permits you to use the Software, as well as the accompanying "on-line" or electronic    
documentation, on a single computer.    All users are granted a limited license to copy and freely distribute
the Software only for the purpose of allowing others to try it, subject to the restrictions in Section 3 as well 
as the following:

a) The Software must be distributed in absolutely unmodified form including ALL program, documentation,
and other files;

b) No charges or payment may be levied or accepted for the Software.

Bulletin board system operators, online services, FTP sites, and computer user groups may post and 
distribute the trial version of the Software without written permission only if the above conditions are met.

2.    Copyright.    The Software (including any images, video, audio, and text incorporated into the 
Software) and related documentation are copyright and are exclusively owned by The Limit Software.    
You may not use, copy, modify, or transfer the programs, documentation, or any 
copy of the Software except as expressly provided by this Agreement.    The Software is protected by 
United States copyright laws and    international treaty provisions.

3.    Other Restrictions.    You may not rent or lease the Software;    reverse engineer, decompile, 
disassemble, modify or translate the Software or documentation; sell or distribute the Software for money 
or other considerations; or in any manner or through any medium    whatsoever commercially exploit the 
Software or use the Software for any commercial purpose. 

4.    Warranty and Disclaimers.    TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE 
LIMIT SOFTWARE DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER 
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.    NEITHER THE LIMIT 
SOFTWARE NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, 
OR DELIVERY OF THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR 
INCIDENTAL DAMAGES ARISING OUT OF THE USE, ABUSE, ATTEMPTED USE, OR INABILITY TO 
USE SUCH SOFTWARE, EVEN IF THE LIMIT SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES OR CLAIMS.    IN NO EVENT SHALL THE LIMIT SOFTWARE'S LIABILITY FOR 
ANY DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE, 
REGARDLESS OF THE FORM OF THE CLAIM.    THE PERSON USING THE SOFTWARE BEARS ALL 
RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE.

SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO 
YOU.



5.    Governing Law.    This Agreement shall be governed by the laws of the State of Indiana and shall 
apply to The Limit Software and any successors, administrators, heirs and assigns.    Any action or 
proceeding brought by either party against the other arising out of or related to this agreement shall be 
brought only in a STATE or FEDERAL COURT of competent jurisdiction located in Lake County, Indiana.   
The parties hereby consent to jurisdiction of said courts.

6.    U.S. Government Restricted Rights.    Use, duplication or disclosure by the Government is subject to 
restrictions set forth in subparagraph (a) through (d) of the Commercial Computer Restricted Rights 
clause at FAR 52.227-19 when applicable, or subparagraph (c) (1) (ii) of the Rights in Technical Data and 
Computer Software clause at DFARS 252.227-7013, and in similar clauses in the NASA FAR 
Supplement.    Manufacturer is The Limit Software, Inc., PO Box 580, East Chicago, IN 46312-0580.

Copyright 1997-2000 The Limit Software, Inc.    All rights reserved.    All other names are trademarks of 
their respective holders.

        



Cookie Crusher Order Form
If possible, please type in your using our Web order form.    These prices are subject to change without 
notice after January, 2001.

To print this order form click on the “Print” button above.    If you do not own a printer, fill out the 
information on a separate sheet of paper and send it to us with your payment. 

Send this order form to: The Limit Software
PO Box 580
East Chicago, IN 46312

USA

Name: _______________________________________________
Company: _______________________________________________
Address: _______________________________________________
City: _______________________________________________
State/Province: _______________________________________________
Zip/Post Code: ____________________      Country: __________________
E-Mail Address: _______________________________________________

Cookie Crusher Single Copy License:

_______ unit(s) of Cookie Crusher at $15 each = _______

Cookie Crusher Site License (for businesses or organizations):

2    to      9 computers: _______ computers at $12 each = _______
10 to 24 computers: _______ computers at $10 each = _______
25 to 49 computers: _______ computers at $9 each      = _______
50 or more computers: _______ computers at $7 each      = _______

Disk Set:

____ Cookie Crusher on 3.5” disk media for $5 shipping & handling.

Payment Method (for credit card orders):

_____ Visa _____ MasterCard _____ American Express

Account Number:  ________________________________ Exp. Date: ________
Card Holder’s Name:  ________________________________    
Card Holder’s Signature: ________________________________ (required to process)

Totals:

Sales Tax (IN residents only): $ _______
Grand Total: $ _______



Filters Tab
This page displays two lists of web sites (or servers) from which cookies will be automatically accepted or 
rejected. In addition, you can specify how cookies not on these lists should be handled.

The lists contain servers (or web site names) in the form of their domain names or IP addresses. For 
example, you could add “www.thelimitsoft.com” to the reject list to always reject any cookies you receive 
from The Limit Software’s web site, or you could add 209.68.15.185 to the accept list to always accept 
cookies from the web server at address 209.68.15.185.

For more stringent control over cookies originating from any web site (or server), you can add the server 
name, followed by a semi-colon, and finally the cookie name.    For example, if 
“www.thelimitsoft.com;SAFE_COOKIE” was listed in the “Reject from” list, only SAFE_COOKIE would be 
rejected from the domain www.thelimitsoft.com.    All other cookies from that domain would be handled in 
accordance with the “Unknown Cookie Option” selection (see below). 

Accept cookies from

This list displays the servers that you will always accept cookies from. You can click on the “Add” button 
below this list to add a new server to the list, or you can select a server from the list and click on the 
“Delete” button below the list to delete a server from the list.    To modify an item currently in the list, click 
on the item and then click on the “Edit” button below the list.

Reject cookies from

This list displays the servers that you will always reject cookies from. You can click on the “Add” button 
below this list to add a new server to the list, or you can select a server from the list and click on the 
“Delete” button below the list to delete a server from the list.    To modify an item currently in the list, click 
on the item and then click on the “Edit” button below the list.

Cookie Crusher stores the site filtering files in "FILTER.DAT" and "FILTER2.DAT."    The former handles 
the accept list, while the latter handles the reject list.    Both files can be manually edited with a text editor, 
since they are stored as plain ASCII text files.    This makes it easy to accept or reject items by pasting 
them from your bookmark or favorites list.

Using wildcards in filters

You can use the wildcard character (*) in filters to accept or reject cookies from all web sites on a given 
domain. The asterisk can be used at the start of a domain name or at the end of a numeric domain 
address. 

For example, specifying “*thelimitsoft.com” as a filter will match www1.thelimitsoft.com, www2.thelimitsoft,
and xyz.thelimitsoft.com. 

Cookies from unknown servers

The options in this group allow you to specify what should be done when a cookie is received from a 
server not in either of the two lists above. You can choose from the following three options:

Reject all – Set this option to automatically reject any cookies received which are not in the “accept from” 
cookies list. 
Accept all – Set this option to automatically accept any cookies received which are not in the “reject” 
cookies list. 
Ask for confirmation – Set this option to bring up a dialog box whenever a cookie is received from a site 
that is not in the above lists. The dialog will display information about the cookie and then will ask whether



or not you want to accept the cookie. You can answer using one of the following buttons in this dialog box:
Reject only those that expire – If this option is selected, Cookie Crusher will reject unknown cookies 
that expire.    In other words, any cookie that would be stored on your system and listed under the Cookies
tab would be rejected.    Temporary cookies that are not stored on the system would be accepted.

The Cookie Alert Window

· Accept - Selecting “Accept” will accept the cookie just this one time. If the cookie is received again in 
the future, you will be notified again.

· Reject - Selecting “Reject” will reject the cookie just this one time. If the cookie is received again in 
the future, you will be notified again.

· Always - Selecting “Always” will accept the cookie and then add the name of the server from which 
the cookie was received to the “accept from” list. Whenever any cookies are received from this server 
in the future, they will automatically be accepted.

· Never - Selecting “Never” will reject the cookie and then add the name of the server from which the 
cookie was received to the “reject from” list. Whenever any cookies are received from this server in 
the future, they will automatically be rejected.

· Help – Displays this help topic.

Cookie Classification
The cookie classification option gives you Cookie Crusher’s best estimated opinion on what the cookie’s 
function is.    The degree of certainty would be indicated as checkmarks next to the button with this 
classification.    

4 Checkmarks Extremely certain of the cookie’s function
3 Checkmarks Very certain of the cookie’s function
2 Checkmarks Somewhat certain of the cookie’s function
1 Checkmark Educated guess

If you click on the button with the classification’s name as the title, you can receive more information on 
what the cookie does.

Wildcard Domain Checkbox
When the confirmation window pops up, a checkbox will appear in the lower left hand corner of the 
window.    The checkbox allows you to use a wildcard server name, such as *thelimitsoft.com,” instead of 
the server name that sent you the cookie.    This feature is useful when you click the always or never 
buttons because it stores the wildcard server name into the appropriate site filter listbox.    This way you 
will accept or reject cookies from the entire domain, instead of just an individual server.

Cookie Name Checkbox
When the confirmation window pops up, a checkbox will appear in the lower right hand corner of the 
window.    The checkbox allows you to use the cookie name with the server name.    This feature is useful 
when you click on the always or never buttons, and want to restrict the program to automatically handling 
a particular cookie from the server.    This option can be used in conjunction with the Wildcard Domain 
Checkbox (see above). 



What’s New?

Cookie Crusher v2.6b

· Fixed problem with Cookie Crusher and non-English browsers.

Cookie Crusher v2.6a

· Added additional support for Internet Explorer 5.5.
· Fixed problem with Cookie Crusher not always working at start-up.

Cookie Crusher v2.6

· Added “edit” box to the “Filters” tab so users can edit cookies already in the “Accept from” or “Reject 
from” list.

· Modified “Cookies” tab to support multiple paths for those with multiple cookie files.
· Eliminated the need to check the “IE 5.x Style” under the “Configure” tab.
· Added the ability to turn off warning boxes that pop-up during normal program operation.
· Tweaked underlying program procedures for improved reliability

Cookie Crusher v2.5

· Specify particular cookies from servers to add to the “Accept from” or “Reject from” list.    For example,
a user could reject a User ID cookie from thedomain.com, yet accept a shopping cart cookie from that
same server (domain).

· Reject only those that expire option added to the “Unknown Cookies Option” list under the “Filters” 
tab.    In addition to prompting, rejecting all, and accepting all cookies that are not in either the “Accept
from” or “Reject from” list, Cookie Crusher can now reject cookies that expire (and would be stored on
your system), yet accept all temporary cookies that would not be stored on your system.

· Limited Opera support is now available with Cookie Crusher.    Opera users can view and delete 
stored Opera cookies.    Cookie Crusher cannot currently control Opera cookies in real-time.

· The “Session” and “Stored Cookies” lists can now be sorted by any category.
· Reset button added to the “Settings” tab.    This button will reset all the Language Settings to the 

original Cookie Crusher defaults.




